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ICCD is a CD Audio player for Windows 95 and Windows NT 4.0. It has been specially designed for these systemes and 
uses a lot of features of these environments.

Click on the program element you want information about :

· How to Register this program ?

· Some tips

· New features of this version

· Distribution

· Disclaimer of Warranty

· Version history of ICCD

· Thanks



How to register
This is not free software.    You are hereby licensed to use this software for evaluation 

purposes without charge for a period of 30 days.    If you use this software after the 30 day 
evaluation period a registration fee of US $10 or 50 FF. is required.    

You have two solutions to register ICCD :

1) Use a secure registration with Regnet. Regnet will accept all the major credit cards and has a toll free 
number.

Phone : U.S.A. : 1 800 WWW2REG (1 800 999-2734)
International: (805) 288-1827

Mail : RegNet - The Registration Network
21200 Trumpet Drive #201
Santa Clarita, CA 91321-4441
U.S.A.

Internet : http://www.swregnet.com/652p.htm

A $5 fee for shipping and handling will be added for this registration.

2) Use the normal registration by sending me a $10 or 50FF or by INTERNATIONAL money order. 
Payment should be sent to:

Laurent THIRY
“ Les Amaryllis ”

379, chemin du Serrier supérieur
06320 La Turbie

France

Cash and International money orders accepted only. Checks will NOT be accepted even
EuroCheques (they cost too much to process).

When payment is received you will be sent a code that will register your version of ICCD. 
For any questions, contact the author at his e-mail address: 

thiry@inforoute.cgs.fr

Unregistered use of ICCD after the 30-day evaluation period is in violation 
of U.S. and international copyright laws.





ICCD Registration form
Print the following form and fill it.

Personnal information     :  

First name : ________________________
Last name : ________________________
Address : ______________________________________

______________________________________
______________________________________

Zip Code : _________________ City : _______________________
State : _________________ Country : _______________________
Your e-mail adress : ________________________________________________

ICCD Information     :  
Version of ICCD : ________________ 
System : [_] Windows 95 [_] Windows NT [_] Other :_____________
Computer : [_] 486 [_] Pentium [_] Pentium pro [_] Other :_____________
Memory : _____________ Mo Disk : ________________ Mo
Sound Card : _________________________________
CD-ROM Drive : _________________________________
How did you get ICCD :
[_] Magazine : _____________________ [_] Internet @ : ftp://___________________
[_] Friends [_] Other : _________________________________
Did you find some bugs :____________________________________________________
New features you want to have in future versions of ICCD :
_________________________________________________________________________
_________________________________________________________________________
_________________________________________________________________________
_________________________________________________________________________



Some tips ...
To run ICCD more efficiently, try these tips :

·  Go to http://www.inforoute.cgs.fr/thiry to get some free ICCD Display Themes (IDT).

·  Use the right-button menu to quickly access commands.

·  To    show or remove the title bar and pull-down menus quickly, just double-click anywhere on the display !

·  To move the ICCD window, you don’t need to have the pull-menu and the title bar displayed, just left-click anywhere on 
the display and drag the mouse, the program will follow your movment !

·  When you have put ICCD in the tray bar, use the QuickPlay feature to play and pause quickly your CD. Just left click on
the icon in the tray bar. If the CD is playing it will pause and if it is paused, it will play.

·  It is easy to select a track when ICCD is in the tray bar, just use the right-button menu and select the track option !



The right-button menu
The right-button menu allows you to perform most of the operation with just one click.

 
You can :

· Play a song or pause the current playing
·  Stop the playing
· Move one track up or down
· Select directly any track of the disk
· Put the program in the tray bar
· Quit the program.



Distribution of this program
Provided that you verify that you are distributing the Shareware Version (select "How to register" from the ICCD Help menu 

to check) you are hereby licensed to make as many copies of the Shareware version of this software and documentation as you 
wish; give exact copies of the original Shareware version to anyone; and distribute the Shareware version of the software and 
documentation in its unmodified form via electronic means.    There is no charge for any of the above.

You are specifically prohibited from charging, or requesting donations, for any such copies, however made; and from 
distributing the software and/or documentation with other products (commercial or otherwise) without prior written permission, with 
one exception:    Disk Vendors approved by the Association of Shareware Professionals are permitted to redistribute ICCD, subject 
to the conditions in this license, without specific written permission.



Disclaimer of Warranty
THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT WARRANTIES 

AS TO PERFORMANCE OF    MERCHANTABILITY OR ANY OTHER WARRANTIES WHETHER EXPRESSED OR 
IMPLIED. Because of the various hardware and software environments into which ICCD may be put, NO 
WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS OFFERED.



Version history of ICCD
· 3.3b Now you can register ICCD with your credit card. ICCD is a member of the RegNet network. The registration is 

now securised and quick. Just call RegNet and they will give you your personal registration code. This version adds a accelerator 
key for the tray bar. If you want to put ICCD in the tray bar, just push the “ T ” key !

· 3.3a. The bug of “ Lost Window ” has been fixed. You can now stop playing when you quit ICCD. The “ Nag screen ” will 
appear after the 30 days evaluation period. When AutoPlay has been deactivated, you can recognize the CD by pressing the Eject 
button. You can resize the ICCD Window when the display song option is enabled.

· 3.3. ICCD Display Themes (IDT) added. You can choose a display theme in the Option Menu, tab Theme. The random 
routine has been rewritten : a track will play once only. The program module has been rewritten. It is full drag and drop. Now, you 
can change the order of your program list without clearing all the list. Any track is directly accessible via the right-button menu. The 
CD door will now close with the eject command. The NT 4.0 Tray Bar bug has been fixed. The display menu bug in Windows NT 4.0
has been removed. New Ergonomy and Quick Access tabs in the Options dialog box.

· 3.2a. This versions adds ScreenTracking, QuickPlay, Separator characters selection, context help in th option menu, ticks 
in display menu ... Tooltips are Microsoft compatible. Volume Icon appears under Microsoft Windows NT 4.0 Beta 2. This version 
also enhances performances of ICCD (ICCD scans no longer the CD-ROM drive all the times to look for the inserted CD)

· 3.2. This version is Microsoft CD Audio Player compatible. If you have filled the Microsoft’s program database, ICCD 3.2 
is able to retreive information about a disk without user intervention. The ICCD DataBase will be automatically filled by the program. 
Tool tips for each button have been added. When the cursor stays over a button for a moment, a tip is displayed explaining the 
button's function. The bug of a lot of resources being depleted when you wanted to change the display color has been fixed. There's
a new registration mode. Now you need to enter your name along with the code. (If you already registered the program, send me 
regular mail or email with the address you previously gave me and I will send you a new registration code. I need the exact 
address!) The volume control bar has been added to control the CD Player's volume. The no sound button has been added to turn 
off the CD Player's sound output. (This can be very useful when your boss comes in!) The bug of the window position not saving 
when using the x button on the application bar has been fixed. The bug that when you were using the scroll bar, you couldn't use the
keys afterwards to control the CD's play has been fixed too. You can now have the right-button menu on a button. The Help menu in
the English version has been fixed with a comprehensive English text. You can put the program in the Windows 95 tray bar to have 
more desktop space.

· 3.1b. Ergonomic bugs fixed. The Player can now be always on top. The position of the player is saved when quitting, so 
when you run it the next time it will be at the same position on your screen. Multi-language Dialog Boxes (English & French) were 
added. Control buttons are now disabled when there is no audio CD in your CD-ROM drive.

· 3.1a. This version fixes several bugs, like the grid display. The Grid is now colored like the other displays. The grid now 
accepts CDs with 25 tracks or more. The awful "No Disk" bug, which was making the program hang, is now fixed.

· 3.1. With this version you can change the colour of the main display. You can choose a 16 million color palette.You can 
quit the program with the right-click menu.

· 3.0a. You can play the music just by pressing the "P" key. Stop the music with the "S" key.



ICCD Display Themes
ICCD Display Theme (IDT) is a new technology that allows you to change your ICCD display. To install a new theme, copy 

the .IDT file in the WINDOWS\ICCD directory. Go in the theme tab of the option menu and select the theme you want to use. That 
will change the aspect of the LCD Display, the buttons and the icons. It will not change the other settings.

If you are a programmer, you can easily create and sell your own ICCD Themes. You just need a C compiler and a 
registred version of ICCD. Contact the author for more information.



The ICCD menu
The File menu :

Quit

The Disk menu :
Play / Pause allows you to play or pause the current track
Stop stops the playing
Track up moves one track up
Track down moves one track down
Forward plays 5 seconds forward
Rew plays 5 seconds backwards
Eject opens or closes the CD tray
No repeat plays normally the CD (stops at the end)
Repeat disk repeats all the disk
Repeat track repeats the current track
Random play plays randomly the disk
Disk title assigns a name to the disk
Track title assigns a name to each track of the disk

The Display menu :
Menu displays or not the menu (see the tips for more details)
Icons displays or not the icon bar
Display displays or not the display
Volume displays or not the volume bar and volume icon
Grid displays or not the grid for quick track access
Songs displays or not the songs list box
CD title displays the CD title or the current track title
Time information displays the time information about the CD or the current track
Elapsed if the Time information option is enabled, displays the elapsed time for the current track
Remaining if the Time information option is enabled, displays the remaining time for the current track
From start if the Time information option is enabled, displays the time elapsed from the begining of the CD
To end if the Time information option is enabled, displays the time remaining to the end of the CD
Always on top allows the program to stay visible even if you are working on another window
Append in tray bar puts the program in the tray bar

The Special menu :
Program makes a program list of your songs
Options allows you to configure the program
Display color allows you to change the display color and to choose into a 16 millions color palette

The Help menu :
Contents makes you go to help ...
About ICCD displays information about the author
How to register displays information about registrating the program (if the program is not already registred) (Did 

you registered it Dude ?)



The display

 

The display is located in the center of the program and inform you about :

·  The main information (title or time information. In this case, the track number is in the left of the display and the time is 
in the right)

·  What is displayed : the title (of the album or of the track) or the time information

· The time information mode (elapsed, remaining, from start, to end) see menu

· The repeat mode (normal, repeat, repeat one, random)



Thanks
Many thanks for debugging ICCD to :

· Gérald BASTELICA, the “ Céleste débugger ”

·  Gilles ORSINI (GNN)

·  Christophe ROVILLO (Gonzo)

·  and Ted TATMAN for helping me to debug and translate the files from French to English



This button allows you to play or pause the current CD track.



Stops the play of the disc and puts the current track to 1.



This button allows you to eject the CD.



This list box contains the different songs of your CD. If you want to listen to a particular song, just double click on it !



This scrollbar allows you to go in a particular point of the song. When you move the scrollbar cursor, the display will show you the 
exact time.



With this scroll bar, you can change the CD volume.



This button makes you go to the previous track.



This button makes you go to the next track.



Fast Forward button.



Review button.



This is the quick track access. Just click on the track number. The grid also show you the number of tracks of the CD (if under 25) 
and the current track.



Turns the volume on and off.



Displays time information about the disk or the current track.



Displays the title of the CD    or of the track.



Displays the time elapsed.



Displays the time remaining to the end of the track.



Displays the time to go to the end of the disk



Displays the time elapsed from the begining of the disk.



Plays normally the disk (stops at the end).



Repeats the entire disk.



Repeats the current track.



Plays randomly the CD.



When you select a time option such as elapsed, remaining, ... ICCD is automatically switching the view in time mode



When you move ICCD, it can’t go out of the screen



When ICCD is in the system tray bar, if this option is enabled, to play or pause the CD, just left click on the icon



The tracks in the grid are appear grayed when you’ve read them



The current playing track number is flashing in the grid



The background of ICCD appears in gradient



When you activate this option, tooltips on ICCD buttons appears





If this option is enabled, when you quit ICCD, it will stop playing the CD




